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Introduction

Introduction

Sage, the recognized leader in accounting software for small- and mid-size businesses, welcomes you to 
Sage 100. 

About This Guide
The Getting Started Guide is for people who are new to Sage 100. Before you begin using the software, 
read this guide for a general overview of system features, common procedures, and other important 
information. 

Some sections of this guide reference Business Insights Reporter and the eBusiness Manager, Material 
Requirements Planning, and Work Order modules, which are not available for Sage 100 Premium.

Where to Find Information
Your Sage 100 system is a powerful, flexible program. The software provides several resources to help 
answer your questions. Sources of documentation include the Help system, the Installation and System 
Administrator's Guide, and additional documents. Customer Support is available as well.

Help System

Use the Help system when you want overview information, selective procedures for day-to-day 
processing, or detailed information and entry samples for a specific field. For more information, "Using 
the Help System" (page 22).

Installation and System Administrator's Guide

An Installation and System Administrator's Guide is available on the Sage 100 documents page. This 
guide provides the information necessary for installing the software, detailed system requirements, and 
troubleshooting tips on the configuration of the various operating systems and environments in which the 
software is supported. It is designed to function as a self-teaching guide. 

Customer Upgrade Guide

If you are upgrading from a previous version of the software, review the Customer Upgrade Guide, which 
provides information on the changes to expect after upgrading to a new version of Sage 100. This guide 
lists changes to the software that may affect your daily business processes. This guide is is available on 
the Sage 100 documents page.
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Where to Find Information

What's New

To learn about the latest software enhancements, click the Help tab at top of the Sage 100 Desktop, and 
then click What’s New. For more information, see "Using the Ribbon" (page 5).

Additional Documents

Additional documents provided for your benefit include Release Notices, Supported Platform Matrices, 
product update information, and file layout and program information. 

Use the Release Notes to learn about program fixes incorporated in the Sage 100 release.  To view the 
release notes, access the What's New page and then click Release Notes.

For a complete list of system requirements, refer to the Supported Platform Matrix, which is available in 
article ID 47649 in the Sage Knowledgebas.

Customer Support

Sage Business Care Support Plans provide you with the technical expertise you need to keep your 
accounting system running smoothly. For more information about these plans, call 1-866-709-2432. 

Customer support is available online through the Sage Support page.

Visit Sage City to ask questions and share tips and tricks. 
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Navigating in Sage 100

Navigating in Sage 100

Start your introduction to Sage 100 by learning about the common buttons and icons, different views, 
navigation tips, and common functionality available in maintenance and data entry windows. 

Note: The screens in this article reflect the ABC company demonstration data, which can be 
installed with your software at any time.

Getting to Know The Desktop
The Sage 100 Desktop provides access to all installed modules; understanding how it works allows you 
to navigate throughout the software. You can also use the Desktop to complete other tasks, such as:

 l Selecting a company

 l Changing a module's accounting date

 l Accessing self-help and support resources

You can customize the Desktop by selecting different options on the View tab and adding items to your 
Favorites list. 

Desktop Overview

Below is a brief description of the main parts of the Desktop. The following pages contain more detailed 
information and step-by-step instructions for the key features.

3Sage 100 Getting Started Guide



Getting to Know The Desktop

Ribbon — The ribbon allows you to change the current company and date, log on as a different user, start 
integrated products, access modules and tasks, and customize the appearance of the program.

Navigation Pane — The navigation pane provides another way to switch between modules and access 
web content in the Desktop browser. You can also create a Favorites list of shortcuts to Sage 100 tasks, 
other programs, files, and folders.

Task Pane — The task pane displays the menus for the current module. You can access tasks from the 
menus and search for tasks from the search field. 

Status Bar — The status bar displays the current company, module, user, and accounting date for the 
current module. You can click in any of these areas to change the applicable item. For example, click the 
current module to switch to a different one.
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Getting to Know The Desktop

Desktop Browser — The Desktop browser displays web pages that are installed with Sage 100, Sage 
CRM when started from the ribbon, and other pages that are added to the Web Content group in the 
Navigation pane. 

Quick Access Toolbar — The Quick Access toolbar allows you to create shortcuts to the Change Current 
Module and Change Secondary Company commands and all commands on the View tab. To add one of 
these commands to the tab, right-click it, and select Add to Quick Access Toolbar.

Using the Ribbon

The ribbon contains a minimum of four tabs, and you can add a Favorites tab as well. You can minimize 
the ribbon so that only the tab names appear, or you can hide it completely. 

Minimizing or Hiding the Ribbon

To minimize the ribbon, click the Minimize button. Only the tab names will appear. Click the Expand 
button to restore the ribbon to it’s full height. 

Click the Hide button to hide the ribbon. When the ribbon is hidden and you need to view it, click in the 
area at the top of the Desktop to make it temporarily reappear. Click the Hide button again to permanently 
unhide the ribbon. 

Accessing Modules and Tasks

On the Modules tab, click Change Current Module to open the Change Module window and select a 
module. The current module menus then appear on the right. You will see only the modules and tasks to 
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Getting to Know The Desktop

which you have access based on your assigned user role.

Using the Keyboard to Access Modules

You can use keyboard shortcuts to change the current module. 

To use the keyboard to change the current module

 1. Press ALT.

 2. Press M. 

 3. Press C and then H. The Change Module window opens.

 4. Type the first letter of the module name to select that module. 

If two modules begin with the same letter, type the letter twice. Alternately, use the Up Arrow and 
Down Arrow keys to highlight a module.

 5. Press Enter.
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Getting to Know The Desktop

Changing the Font Size

On the View tab, click Application Scaling and select a font size. The text on both the Desktop and the 
task windows is resized. 

Alphabetizing Modules, Module Menus, and Tasks

On the View tab, in the item arrangement group, select the available check boxes to alphabetically sort 
the module list, the module menus, and the tasks. 

Adding the Favorites Tab

If you’ve created a Favorites list, you can access it from the ribbon by adding a Favorites tab. Right-click 
any item in the ribbon, and select Show Favorites in the Ribbon. For information on creating a Favorites 
list see "To add a program, file, or folder to the Favorites group" (page 10).

Using Key Tips

Press the ALT key to view key tips indicating which keyboard shortcut keys activate the associated 
options. When the key tips are visible, press the specified key to select an option. 

Using the Navigation Pane

The navigation pane allows you to change the current module, open web pages in the Desktop browser, 
and create a Favorites list with shortcuts to Sage 100 tasks, files, folders, and other software programs.

7Sage 100 Getting Started Guide



Getting to Know The Desktop

Switching Between Open and Collapsed View

You can keep the navigation pane open so that the content is always visible, or you can use the 
collapsed view to save space. When using the collapsed view, click the pane to view the content. 

Accessing Modules and Tasks

Use the Modules group in the navigation pane to select the current module. The task pane is updated as 
you switch modules.

Click menu names to expand and collapse them, and click task names to open the tasks.

Use the search box to search for a task. The search results include all matching tasks for which you have 
the appropriate security setup, even if they are not in the current module.   
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Getting to Know The Desktop

Viewing Web Content

When you click a link in the Web Content group, it opens in the Desktop browser. You can add links to 
this group. 

To add links to the Web Content group

 1. On the ribbon, click the View tab.

 2. Click Edit Web Content. 
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Getting to Know The Desktop

 3. Click New, and then click Link.

 4. In the Link window, enter a URL and the title that you want to appear in the Web Content group. 

 5. Click OK. 

The link is added to the Web Content group of the navigation pane. 

For more information about the browser, see "Using the Desktop Browser" (page 12).

Creating Favorites

You can add shortcuts to Sage 100 tasks, files, folders, other programs, and web pages to the Favorites 
group.

To add a Sage 100 task to the Favorites group

There are two ways to add a task to your Favorites list:

 l Drag the task from the task pane to the Favorites group. 

 l On the task pane, right-click a task, and then click Add to Favorites.

To add a program, file, or folder to the Favorites group

There are several ways to add a shortcut to a file, folder, or another program to your Favorites list:

 l Drag a shortcut from your Windows desktop to the Favorites group.

 l Drag a program from the Windows Start menu to the Favorites group.

 l Drag a file from a File Explorer window to the Favorites group.

 l Right-click in the Favorites group and then click Insert Shortcut. In the Shortcut window, browse to 
the item and enter a title.
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Getting to Know The Desktop

To add a shortcut to a web page to the Favorites group

In the Web Content group, start dragging a link. The link will be automatically added to the Favorites 
group.

To add a shortcut to the Public Favorites group

You can add shortcuts to the Public Favorites that is available to all users (based on their security setup). 
You must also have the appropriate security setup to complete these steps. 

 1. Log into the server where Sage 100 is installed, and then start Sage 100. 

 2. In the navigation pane, click     Modules and select a module. 

 3. In the task pane, locate the     task.

 4. In the navigation pane, click Favorites. 

 5. Click Public Favorites. 

 6. Drag the task to the navigation pane. 

The task is now available to all  users who have the appropriate security setup to access it. 
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Getting to Know The Desktop

Using the Desktop Browser

The browser embedded in the Sage 100 Desktop is used to display web pages accessed from the Web 
Content group, visual process flows, and Sage CRM when started from the ribbon. 

You can have multiple tabs open at the same time and drag the tabs to rearrange them. 

To open a tab in an external browser window, right-click the tab and then click Open in New Window.

For more information on the web pages that are installed with Sage 100, see "Desktop Web Pages" 
(page 13).
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Desktop Web Pages

Desktop Web Pages
The Desktop Web pages available are the Information Center page, Resources page, Feature Tours 
page, and Business Insights Dashboard page. To display a web page, select the page from the Web 
Content area.

Information Center Page

From the Information Center page, you can find information about integrated solutions and Sage training 
and support. There is also a Feedback Site link; click the link to provide your ideas and feedback directly 
to Sage.
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Desktop Web Pages

Resources Page

From the Resources page, you can access the What's New page to learn about the latest software 
enhancements, view this Getting Started Guide, the Customer Upgrade Guide, and module overview 
documents, access the product’s Help system, and view file layout and program information.
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Becoming Familiar with Maintenance and Data Entry Windows

Business Insights Page

The Business Insights Dashboard page provides a customizable graphical summary of your company’s 
financial data.

Becoming Familiar with Maintenance and Data Entry 
Windows
Throughout the software, maintenance and data entry windows share a common set of controls which 
make learning the software quick and easy. Before you begin entering data and performing common 
tasks, let's look at examples of these windows.

Note: The task windows appearance will vary depending on which theme is selected in Company 
Maintenance, but the functionality is the same. 
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Becoming Familiar with Maintenance and Data Entry Windows

Sample Maintenance and Data Entry Window

This sample window shows common data entry features shared by maintenance and data entry 
windows. Some features may not appear in all windows.

Sample Accounts Receivable Line Entry Window

This sample Accounts Receivable Lines tab window shows common grid entry features shared by data 
entry windows in modules other than Material Requirements Planning and Work Order. 

In addition to the features illustrated below, you can personalize a data entry grid to allow for fast and 
efficient entry of data. Most columns in a grid can be moved, resized, or hidden. You can also freeze a 
column of data so that a particular column remains in view during scrolling. You can resize the data entry 
window, and the Primary and Secondary grids as well. All personalizations to grids are saved for your 
future data entry sessions.
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Becoming Familiar with Maintenance and Data Entry Windows

Another feature of data entry windows in modules other than Material Requirements Planning and Work 
Order is the right-click menu.

 l Right-click outside of a grid to access system information and other tasks. 

 l Right-click any field in a grid to access additional tasks related to the field.
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Becoming Familiar with Maintenance and Data Entry Windows

Understanding Basic Types of Data

During data entry, you may need to enter the following basic types of data.

 l Text: Unformatted entries of alphabetical information (for example, names, addresses, and 
comments) are text entries. 

 l Dates:

 l Enter a two-digit month (MM), followed by a two-digit day (DD), followed by either a two-digit 
(YY) or four-digit year (YYYY). Six or eight characters can be entered for the date. If a two-
digit year is entered, the century is determined by the century preferences setting in the 
Windows Control Panel.

 l You do not need to put a hyphen (-) or slash (/) between the day, month, and year; 
punctuation is inserted automatically. For example, to enter May 31, 2010 at a data field, 
type 053110. (Do not forget the leading zero.) 
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Becoming Familiar with Maintenance and Data Entry Windows

Note: The M/d/yyyy format is the default date display format. The format of the date is set from 
the Windows Control Panel.

 l Numeric Data:

 l Empty numeric fields (zero value) display a mask indicating the number of digits that can be 
entered to the right of the decimal point. For example, .00 appears if the numeric field 
accepts two-decimal precision. 

 l Some numeric fields (for example, quantity and hour fields) do not assume the decimal 
point.

 l To enter negative numbers, type the negative sign (-) as either the first or the last character 
of the entry.

 l Account Numbers 

 l General ledger account numbers are structured fields consisting of one or more segments 
separated by a hyphen (-) or other separator selected at the Account Number Separator field 
in Account Structure Maintenance.

 l You can enter the value for each segment separated by a hyphen (-). You can also zero, or 
blank fill, each segment to its maximum number of characters without using the hyphen (-). 

 l Example: An account field with a mask of #####-##-###-###-### processes your entry in 
the following manner. 

Your Entry...                        Displays As...

1-2-4-6-800                           00001-02-004-006-800
1234567891234567              12345-67-891-234-567
010005                                  01000-05-000-000-000

Sorting and Selecting Dialog Box Data

You can sort data in columns in ascending or descending order by clicking the column heading. Click a 
column heading to sort the data in reverse order. Resize the column headings by clicking and dragging 
between the columns.
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Becoming Familiar with Maintenance and Data Entry Windows

You can use the UP ARROW and DOWN ARROW keys to select line items. To select more than one line 
item, press the CTRL key and click the items. To select a range of items, press the SHIFT key, click the 
first item, and then click the last item in the range.

Using the Lookup Feature

When entering data in a maintenance or data entry window, you can click the Lookup button ( )at certain 
fields to display a list of records. You can then select the appropriate record. 

The Lookup feature contains options that allow you to filter and customize the search criteria, and create 
up to 99 custom lookup views. In addition, you can print the list of records appearing in the lookup list 
box. The illustration below shows a lookup window. For more information on using Lookups, see the 
following: 

 l "Using the Lookup's Basic Features" (page 28) 

 l "Using the Lookup's Advanced Features" (page 31)
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Becoming Familiar with Maintenance and Data Entry Windows

Note: The title of the lookup window reflects the name of the field at which you clicked the Lookup 
button.

In some cases you may click the lookup button, and no records appear in the lookup window. This could 
happen for the following reasons: 

 l The number of records is over the limit set at the Lookup Limit for Initial Display field in User 
Maintenance.

 l The Initial Display check box on the fifth User Lookup Wizard page is cleared. For more 
information, see User Lookup Wizard in the Help system.

 l A custom filter that has no result set is in effect.

To display records, filter the information by using the Search, Operand, and Value fields, and then click 
Find.

Navigating with Common Buttons, Icons, and Keystrokes

All maintenance and data entry windows share the same set of buttons and keystrokes to help you 
navigate through data and perform common tasks. If you prefer to use the keyboard while you work, most 
buttons have keyboard equivalents.
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Getting Help While You Work

For a list of common buttons and their keyboard shortcuts, see the Keyboard and Button Navigation 
article in the Sage 100 help. 

Getting Help While You Work
Several sources of information are available to you in the software. Use the following resources to find 
answers to your questions as you work.

Using the Help System

Use the Help system when you want procedures for day-to-day processing, detailed information and 
entry samples for fields, and FAQ and troubleshooting information. Overview information and flowcharts 
illustrating complex concepts are also available in Help. If you do not find what you need, access 
information from the additional resources provided on the Help menu.

Accessing Help

You can access help using any of the following methods:

 l From the Desktop, on the Help tab, click Help Topics. 

 l Press F1 in any field in the software to access help for that field.

 l In the bottom-right corner of any window, click the Help button. Help for the specific window 
appears.

When you access the Sage 100 help, you’ll be taken to the online help site if an internet connection is 
detected. If you don’t have an internet connection, you’ll see the locally installed help instead. 

Customer Support

There are several resources you can use for technical assistance before contacting your Sage business 
partner or Customer Support:

 l Refer to the Help system.

 l Search for answers in the Sage Knowledgebase. 

 l Visit Sage City, the Sage 100 online community. 
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Getting Help While You Work

After using the above options, if you need more assistance, you can start a live chat session with Sage 
Customer Support or enter a support ticket by selecting an option on the Help tab. 
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Learning Common Procedures

Learning Common Procedures

Whether you are new to Sage 100, or an experienced user who wants to review basic and advanced 
concepts, this article gives you hands-on practice with common procedures. 

Note: The Material Requirements Planning and Work Order modules are not available for Sage 100
 Premium.

Companies and users
These lessons describe some of the common tasks related to companies and users. 

Many systems are set up with multiple companies to keep financial records for individual companies 
separate, and to separate real company data from test company data. Each company is identified by a 
unique, three-character company code. You can process information for a specific company by selecting 
the appropriate company code.

A user record must be created for anyone who needs to access Sage 100. 

Creating a Company

To create a company

 1. Select Library Master > Main > Company Maintenance.

 2. Enter a company code and company name.

 3. Enter information in the fields appropriate to your company, including the federal ID number.

 4. Click Activate to activate one or more modules.

 5. When asked to save the new company, click Yes.

 6. When the Activate Module window opens, select the module(s) to activate and click Proceed.

 7. In Company Maintenance, verify that the modules you selected appear in the Activated Modules 
area of the window and then click Accept.

Creating a User

 1. Start User Maintenance. Depending on whether you purchased Sage 100 through a subscription, 
use one of the steps below: 
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Companies and users

 l Select Library Master > Security > User Maintenance. 

 l Select Library Master > Main > User Maintenance. 

 2. Enter the user logon, first and last name, and user code.

 3. If the Use Unified Logon check box is selected in System Configuration, the user logon must match 
the user’s Windows name.

 4. Enter a password. 

A password is required if the Require all Users to Enter a Password check box is selected in 
System Configuration.

 5. On the Maintenance tab, select the company and role to assign to the user.

 6. On the Preferences tab, select user-specific preferences.

 7. If the auto-complete feature is enabled in System Configuration, change the default options on the 
Auto-Complete tab as needed. 

 8. Click Accept.
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Accessing Modules and Tasks

Changing a User Password

User passwords can be changed for any user currently logged onto the system. 

Users can change their own password if the Allow User to Change Password security option is selected 
for their role. 

To change a password

 1. On the Sage 100 Desktop File menu, click Change User Password.

 2. In the Old Password field, type the current password for the user. 

 3. In the New Password field, type the new password for the user.

 4. In the Confirm Password field, type the same password that was typed in the New Password field.

 5. Click OK.

Changing User Settings

The User Settings window allows you to specify default options, such as the default zoom level when 
viewing reports.

To change user settings

 1. Use one of the following methods to open the User Settings window.

 l On the Sage 100 Desktop File menu, click Change User Settings.

 l On the Home tab in the ribbon, click Change User Settings.

 2. Make changes as needed. 

 3. Click Accept.

Accessing Modules and Tasks
The Sage 100 Desktop offers multiple ways to access modules and tasks. In addition to the lessons in 
this article, you can find more information in the "Getting to Know The Desktop" (page 3) article. 

Depending on your company settings, you may be asked to enter an accounting date before accessing 
Sage 100 tasks, or the module date may be set based on your computer's system date. The accounting 
date is printed on all reports, and represents the date to be used while posting transactions for the current 
module.

Changing the Accounting Date

The Library Master accounting date is set from the Windows system date and cannot be changed.
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Accessing Modules and Tasks

To change the accounting date

 1. Use any of the following methods to change the accounting date from the Sage 100 Desktop:

 l On the File menu, click Change Date.

 l On the Status Bar, click in the accounting date area.

 2. Enter the accounting date.

 3. Click OK. The accounting date appears on the Status Bar.

Changing the Module

The active module always displays on the Status Bar. 

Note that modules automatically change when you select a task from another module using the Module 
Menus toolbar or Modules menu.

To change the module

 1. Use either of the following methods to open the Change Module window from the Desktop:

 l On the Status Bar, click the module.

 l On the Modules tab, click Change Current Module. 

 2. Select a module. 

 3. Click OK. 

The new module displays on the Status Bar and the module menus change to reflect the specified 
module.

Opening a Task in a Secondary Company

From the Desktop, you can open a task in a secondary company without changing the current company 
displayed on the Desktop Status Bar. You can select any company as the secondary company.

To open a task in the current secondary company

 1. In the Desktop task pane, click Modules if it’s not already selected.

 2. Right-click a task, point to Open with, and then click Secondary Company. 

The task opens in the secondary company.

To specify a different secondary company and then open the task

 1. In the Desktop task pane, click Modules if it’s not already selected.

 2. Right-click a task, point to Open with, and then click New Secondary Company.
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Using the Lookup's Basic Features

 3. In the Company field, enter a company and then click OK.

The task opens in the secondary company. 

Note: To define a new secondary company without opening a task, select Change Secondary 
Company from the right-click menu.

Using the Lookup's Basic Features
When entering data in certain fields in a maintenance or data entry window, you can click the Lookup 
button to display a list of valid records. This lesson contains basic procedures on how to use the Lookup 
feature. To learn more, see "Using the Lookup's Advanced Features" (page 31).

Using the Lookup to Select a Record

Use the Lookup feature to display a list of records and select the appropriate record.

To select a record using the lookup window 

 1. In a window, click a Lookup button. The lookup window appears displaying the available records.
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Using the Lookup's Basic Features

 2. Select a record and then click Select. 

The record is then selected in the original window. 

Searching in the Lookup

The lookup window provides a Search field and a Find button to narrow your search for desired records. 
This feature is a convenient way to reduce the number of records displayed and helps you to focus on 
pertinent records.

To search in the lookup window

 1. In the lookup window, in the Search field, select the field to search.

 2. In the Operand field, select an operand. For information about available operands, see Filter the 
Lookup Criteria  in the help.

 3. In the Value field, type a search value for the lookup.

 4. Click Find to run the search. The lookup list box displays the search results. In this example, the 
lookup searches and returns all customer numbers that begin with 01.

 5. Select an item from the list box and click Select. 
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Using the Lookup's Basic Features

Filtering the Lookup Criteria

In any lookup window you can define additional criteria to filter the lookup, and you can save these filters 
so that they apply to future lookups until they are manually removed. Filtering the lookup criteria helps 
you narrow your search on desired fields.

Tip: There are two differences between filtering the lookup criteria and searching in the lookup. 
When filtering, you can define an unlimited number of filters on multiple lookup fields, and you can 
save these filters so that they always apply to the lookup. In contrast, when you perform a search in 
the lookup window, you can search on only one lookup field, and the search criteria cannot be 
saved.

To filter the lookup criteria

 1. In the lookup window, click Filters. In the Filters window, each line item is a filter consisting of a 
Column, Operand, and Value. 

Note: Filters that are defined in the User Lookup Wizard and Lookup Customization Wizard also 
appear in this window. If the filter is locked, it cannot be changed. If the filter is not locked, it can 
be removed or modified.

 2. In the Column field, select the lookup column you want to filter. The Column field reflects all of the 
columns defined for the lookup.

 3. In the Operand field, select the appropriate operand. For information about available operands, 
see Filter the Lookup Criteria in the help.

 4. In the Value field, type a value. If you enter multiple values separated by commas, the system 
assumes an "OR" condition.

 5. To add additional filters, repeat steps 2 through 4. You can define an unlimited number of filters; 
multiple filters assume an "AND" condition.
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Using the Lookup's Advanced Features

 6. To retain these filters for future lookups, select the Save Filters check box. 

Note: If the Save Filters check box is cleared, the filters remain in the Filters window and remain 
in effect during the lookup; however, when you exit the lookup, these filters are removed.

 7. Click OK to apply the filters. In this example, the lookup returns all customers beginning with 01 
and ZIP Codes beginning with 5.

Deleting Filters

You can delete filters after they have been defined.

To delete and reset filters

 1. In the lookup window, click Filters.

 2. To delete one filter,  in the filter's Column field, select <none>. The filter row is cleared. 

 3. To delete all filters, click Reset. The filters are cleared, and any filters from the custom lookup, if 
one exists, are restored.

 4. Click OK.

Using the Lookup's Advanced Features
The Lookup has advanced features that allow you to create lookup views, create a numeric lookup field, 
modify a lookup field, and export lookup data to Excel. 
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Note: If another user is in the User Lookup Wizard and is creating or modifying a lookup code while 
you attempt to create or modify a lookup view, a message appears and prevents you both from 
continuing.

Creating a Lookup View

For each lookup by company and by user, you can create up to 99 unique views. When creating a lookup 
view, you can define your default view, add, remove, or modify fields in the lookup, add or remove filters, 
as well as define several other settings. After creating a lookup view, you can modify or delete the view at 
any time. Keep in mind that any search criteria or filters you previously defined will not apply to the new 
lookup view you create.

To create a lookup view

 1. In the lookup window, click Custom. 

Note: The Custom button is not available if the Locked Customization check box is selected in 
the User Lookup Wizard.

 2. On the Lookup Customization Wizard page, in the View field, select Create new view and enter a 
description for the new view. Alternately, select an existing view to modify.

 3. To set the new lookup view as the default view, select the Default View check box. Click Next. 
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 4. In the second wizard page, add, remove, modify, or reorganize the fields for the lookup view in the 
Selected Columns list box. 

In this example, the TelephoneExt and LastPurchaseDate fields have been added to the Selected 
Columns list box, and the ZIP Code field has been moved to the Available Fields list box.
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Note: The first column indicated by an asterisk (*) in the Selected Columns list box cannot be 
removed; however, it can be modified.

 5. Click Next to define additional settings, or click Finish if you have completed customizing the view.

 6. Use the third Lookup Customization Wizard page to add, delete, or modify filters. To continue 
defining additional settings, click Next; otherwise, click Finish. 

 7. In the final Lookup Customization Wizard page, make any final changes to the lookup view.
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 l Select the Initial Display check box to load data in the lookup at run time. If you do not want 
data initially loaded in the lookup at run time because you have a large number of records 
and want to perform a search before displaying records, clear this check box.

 l In the Title field, type a new title that will display in the lookup window title bar. 

 l In the Default Search Column field, select a default field to appear in the Search field in the 
lookup window.

 l In the Default Search Option field, select a default field to appear in the Operand field in the 
lookup window.

 8. Click Finish to see your newly created lookup view. 

 9. The View field appears in the lookup window and the new view, Basic, displays the newly added 
fields. In the example below, the new fields are TelephoneExt and LastPurchaseDate, while the 
deleted ZIP Code field no longer appears. 

Also, the title bar displays Vendor List - Basic because this title was entered in the Title field in the 
last page of the wizard and was set as the default view.
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Creating a Numeric Lookup Field

You can create numeric fields to add to the Selected Columns list box in the second Lookup 
Customization Wizard page. Numeric fields are created by combining two or more fields together using 
arithmetic operators.

To create a numeric lookup field

 1. In the second Lookup Customization Wizard page, click New Field to create a new numeric field 
using simple arithmetic functions.

 2. In the Lookup Customization Wizard - New Field window, in the Heading field, enter the name for 
the field.

 3. Enter the width and select the justification.

 4. Enter the mask. 
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 5. Click the Calculated Field button to enter simple arithmetic calculations in the Calculated Field 
Builder window.

 6. Double-click a field in the Available Fields list. This moves the field to the expression area. Select 
an operator, choose another field from the list, and then click OK.

 7. In the Lookup Customization Wizard - New Field window, click OK. The newly created field 
automatically appears as a column in the Selected Columns list box.
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Modifying a Lookup Field

 1. In the second Lookup Customization Wizard page, click Modify to alter the selected field in the 
Selected Columns list box.

 2. In the Lookup Customization Wizard - Modify window, make the desired changes and click OK. 

For example, you can change the width of the key field to zero if you do not want to display it in the 
lookup.

Exporting Lookup Data to Microsoft Excel

You can export the data displayed in a lookup window to Excel if you have the appropriate security setup. 
You can also select a customized lookup view or perform a search in the lookup window to display 
specific records, and then export the data to Excel.

To export lookup data to Excel

 1. In the lookup window, display the data to export to Excel.

 2. Click the Excel button. The data in the lookup window is exported to Excel.
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Printing Reports, Listings, or Forms
All reports can be printed, exported or written to a file, and stored for deferred printing. You can print a 
report to a variety of printers or output devices. Additionally, reports can be viewed before printing using 
the Preview feature.

Printing a Report, Listing, or Form

Note: These steps apply to all modules other than Material Requirements Planning and Work Order. 

 1. In the task window that has the Listing feature available (for example, General Ledger Options), 
make the needed selections to the criteria in the window and then click Print.

 2. In the listing window that appears, in the Printer field located in the lower-left corner of the window, 
select the printer. 

You can also select alternative printing methods, which are available in the Printer field, including:

 l Export/E-mail: Reports can be exported to different file types, such as PDF or Excel, and 
saved to your hard drive or e-mailed. For more information, "Exporting or Printing to a File" 
(page 44).

 l Data Only Export: This option allows only the data portion of the report to be exported 
(header information is excluded). For more information, "Exporting or Printing to a File" (page 
44).

 l Deferred: Report printing can be deferred allowing you to save reports on your hard drive for 
printing at a future time. For more information, "Using Deferred Printing" (page 41).

 l Office Merge: If the Custom Office module is installed, you can merge your data into a 
template such as a Microsoft Word or Excel template before printing.

 3. Click Print to print the listing. 

Tip: You can click Preview to review the listing before printing.
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To print a report or form

 1. In the report or form window, select either a report setting or a form code.

 2. You can either accept the default settings for the current report setting or form code, or create a 
new report setting or form code. For more information, "Creating a Report Setting" (page 46). 

Note: The standard set of reports and forms are assigned a report setting of Standard.

 3. In the Printer field located in the lower-left corner of the window, select the printer. 

You can also select alternative printing methods, which are available in the Printer field, including:
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 l Export/E-mail: Reports can be exported to different file types, such as PDF or Excel, and 
saved to your hard drive or e-mailed. For more information, see "Exporting or Printing to a 
File" (page 44).

 l Data Only Export: This option allows only the data portion of the report to be exported 
(header information is excluded). For more information, see "Exporting or Printing to a File" 
(page 44).

 l Deferred: Report printing can be deferred allowing you to save reports on your hard drive for 
printing at a future time. For more information, see "Using Deferred Printing" (page 41).

 l Office Merge: If the Custom Office module is installed, you can merge your data into a 
template such as a Microsoft Word or Excel template before printing.

 4. After selecting or modifying the report setting or form code, click Print to print the report or form. 

Tip: You can click Preview to review the report before printing.

Using Deferred Printing

Deferred printing allows you to save reports on your hard drive for printing at a future time. You can batch 
print multiple reports at one time without operator intervention between reports. You can also specify the 
number of copies to print for each report, as well as whether to retain the deferred report information for 
future use after printing. In a multi-user environment, this feature can postpone the report printing 
process if printers are not currently available, or it can speed up the posting process. 

Deferring a Report

You must first set up reports to be deferred for future printing.

To defer the printing of a report

 1. Access the report to defer (for example, the Budget and History Report in the General Ledger 
module) and select the report options.

 2. In the Printer field, select Deferred and the click Print. 

 3. In the Deferred Print Options window, enter the number of copies to print. 
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 4. Select or clear the Purge After Printing check box to either purge or retain the report after printing. 

 5. Select the Secure Report check box to restrict other users from printing the report. 

 6. Click OK. 

The report is generated in a deferred print file and can be printed at a later time.

Printing Deferred Reports

You can print one page of a deferred report or a range of pages. In addition, you can print several copies 
of a report and more than one report at a time. If a report is secured, only the user who initially deferred 
the report can print it.

To print deferred reports

 1. To access and print deferred reports from the Sage 100 Desktop, use either of the following 
methods:

 l On Home tab in the ribbon, click the Deferred Printing button. 

 l On the File menu, click Deferred Printing.

 2. In the Deferred Printing window, select the report(s) to print. 

 l To print all deferred reports, select the Module check box. 

 l To print deferred reports for a specific module, select the module's check box. For example, 
select the General Ledger check box to print all deferred reports in the General Ledger 
module.

42Sage 100 Getting Started Guide



Printing Reports, Listings, or Forms

 l To print only selected reports, select each report check box individually. 

 3. To preview a report, select the report and click the Preview Report button.

 4. To export the report to a different file type, click the Export Report button in the report preview 
window.

 5. To change printing options for a specific report, select the report and click the Show/Modify Report 
Options button. 

In the Deferred Report Options window, change the information as needed and then click OK. 
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 6. In the Deferred Printing window, click Print to print the selected reports to their assigned printers.

Exporting or Printing to a File

Reports can be exported to other files types, such as CSV, Excel, or PDF, and they can be saved to your 
hard drive or e-mailed. You can also export only the data portion of reports (header information is 
excluded).

To export a report

 1. Access the report to export and select the report options.

 2. In the Printer field, select one of the following options:

 l Export: Select this option to export the entire report.

 l Data Only Export: Select this option to export only the data portion of the report (header 
information is excluded).

 3. Click Print.

 4. In the Export window, in the Format field, select the file type for exporting. 

 5. In the Destination field, select the location you are exporting to. For example, you can export the 
report to your hard drive or to an application such as Excel. 
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 6. Click OK.

Sending Faxes

To send a fax from the software, a fax driver must be loaded in the Windows workstation environment. 
The fax driver acts as a printer driver in the software.

To send a fax 

 1. Access the report and set the report options.

 2. In the Printer field, select the fax driver.

 3. Click Preview.

 4. In the report preview window, click the Print Report button.

 5. In the Print window, click OK.

 6. A wizard or window applicable to your fax software opens. Enter the necessary information, such 
as the recipient’s fax number, and send the fax.

Paperless Office

You can use the Paperless Office module to fax, e-mail, and store forms in PDF format. The Paperless 
Office module allows you to set up PDF storage and electronic delivery options for documents in all 
Sage 100 companies. You can specify separate settings for journals and registers, reports, period-end 
reports, and forms.

This module also contains viewers in which you can view, move, delete, and electronically deliver PDFs 
of customer forms, vendor forms, journals and registers, standard reports, and period-end reports.

Purge utilities are also included which allow you to purge PDF documents as needed.

You do not need to enable this module in Company Maintenance; however, you must enable Paperless 
Office functionality for each type of document you would like to store and electronically deliver. For more 
information, see Set Up Paperless Office in the Help system.

Batch Faxing

Batch faxing allows you to fax multiple forms in batches. During the faxing process, forms addressed to 
the same fax number are collected and sent as a group with one cover letter. Batch faxing is set up using 
Batch Fax Options or Fax Form Definition, and requires either the Microsoft Fax Services or WinFax 10 
fax driver.

Forms printed using the following tasks are supported for batch faxing: Statement Printing, Accounts 
Receivable Invoice Printing, Customer RMA Printing, RMA Receiver Printing, Sales Order Printing, 
Picking Sheet Printing, Sales Order Invoice Printing, and Purchase Order Printing. For more information, 
see Fax Multiple Forms in Batches in the Help system.
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Setting Printing Preferences for Dot-Matrix Printers

To achieve optimum printing speed for dot-matrix printers, native fonts can be selected through the 
Windows driver to increase print speed. 

Some printer drivers may only have the Default selection available for the font. If this is the case, you 
must download an updated driver for your printer from the printer manufacturer's Web site or select 
another compatible driver emulation (refer to your printer manual or consult a printer manufacturer for 
details). Each printer has unique font options available. Most native font selections will print faster than 
the Default font selection. 

To set printer preferences for dot-matrix printers

 1. Select Library Master > Setup > Printer Preferences.

 2. In the Printer Preferences window, select the dot-matrix printer from the printer list.

 3. Clear the Enable Graphics Printing for this Printer check box. This setting is specific to the printer 
and overrides the global setting.

 4. Select the Show Native Printer Fonts Only check box. This is a temporary filter and must be 
selected each time you access this window to change a font.

 5. In the Normal Font Name field, select 10 CPI Draft, 10 CPI Courier (not Courier New), or any font 
other than Default.

 6. In the Normal Font Size field (to match the font selected in the Normal Font Name field), select 10.

 7. In the Compressed Font Name field, select a font based on the following:

 l If you are using 8.5- x 11-inch paper on a standard-carriage printer, or 8.5- x 11-inch paper on 
a wide-carriage printer, select 17 CPI Draft, 
17 CPI Courier (not Courier New), or any font other than Default.

 l If you are using 11- x 14-inch paper, select a value between 10 and 15 (this setting may vary, 
depending on which printer driver you are using).

 8. Click Accept.

Creating a Report Setting
After selecting the options and selection criteria for a report, you can save these selections for future use 
by using a unique report setting. You can create and save any number of customized report settings per 
report and company. Use this procedure to save a report setting based on an existing report setting.
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To create a report setting 

 1. In the report window, in the Report Setting field, select the setting to use as the basis for your new 
setting.

 2. To save the report setting based on another report setting, modify the settings in the report 
window,   click the drop-down arrow next to the Save button, and select Save As. You can also save 
the current report setting by clicking Save. 

The settings for the standard set of reports included with Sage 100 cannot be modified. The 
settings made in the report window will revert back to the previous Standard settings. If you’ve 
made changes to the settings, when you click Save, the Save As Report Setting window opens 
allowing you to save the changes using a different setting name.
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 3. In the Save As Report Setting window, in the Description field, enter the description for the report 
setting you are saving.

 4. In the Type field, select the report type option.

 5. To save the report setting as your default report setting, select the Default Report check box.

 6. To set advanced settings for the report setting, perform the following steps:

 a. Click Advanced. 

 b. In the Advanced Setting window, select either the Standard or Custom option to use a 
standard or custom report when printing the report.

 c. If you selected the Custom option, enter the path to the custom report and click OK.

 7. In the Save As Report Setting window, click OK to save the report setting. 

Changes made to an existing report setting are saved to a new report setting name or to the 
current report setting name. The report setting that you created will be available in the Report 
Setting field in the report window for future use.

Note: Report and form printer information is retained by workstation and form code. When a new 
report setting or form code is created, the workstation ID and printer information is retained.

Setting Up Sage Intelligence Reporting
Sage Intelligence Reporting shows your Sage 100 data in Excel templates, which you can view and 
customize. 
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Sage Intelligence Reporting is installed by default when  you install Sage 100 and run Workstation Setup. 
If you modified the default installation setting, you can install Sage Intelligence Reporting at any time. 
Refer to the Sage 100 ERP Installation and System Administrator’s Guide for installation instructions. 

Before using Sage Intelligence Reporting, you must set up a repository and register the product.

The repository will be used to store Sage Intelligence Reporting data, reporting trees, report templates 
and other settings. Centralizing this information in one folder has the following advantages:

 l Using a single folder makes it easier to back up and restore the information.

 l Multiple users can access the information. 

To set up Sage Intelligence Reporting

 1. Create a shared folder to serve as the repository. The folder can be created locally or on a network; 
however, you must use a UNC format when entering the repository path: 

\\server\share name\repository folder name

 2. Grant Sage Intelligence Reporting users read and write permissions to the folder. 

 3. Open the Report Manager from within Sage 100. Select Sage Intelligence Reporting > Reports > 
Report Manager. 

 4. When the window appears asking for the path to the repository, enter the UNC path to the shared 
folder that you created, and then click OK.

 5. When a window appears asking you to run the license manager, click Yes. 

 6. In the License Manager window, enter your Sage customer account number and serial number, 
and then click Apply. 

 7. The serial number is also referred to as an unlocking key. If you do not have your serial number, 
see "Finding Your Serial Number" (page 49).

 8. Click Perform Registration. 

Click the Help button on any Sage Intelligence Reporting window for detailed information about the 
product’s features.

Finding Your Serial Number

If you do not have your Sage Intelligence Reporting serial number, you can find it online at: 
https://customers.sagenorthamerica.com. You’ll need your user name and password. 
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To find your Sage Intelligence Reporting serial number

 1. Log on to the Sage Customer Portal. 

 2. On the Activation Codes menu, click Details. 

 3. In the Product Details grid, in the Application column, look for Intelligence Report Mgr. Your serial 
number is in the Unlocking Key column. 

The serial number is case-sensitive. All special characters must be copied or typed into the License 
Manger window exactly as they appear in the Product Details grid.

You may have additional Sage Intelligence Reporting components listed in the grid. The serial number 
for the Intelligence Report Mgr component will unlock all of the components. 

Setting Up Sales Tax Information
Depending on the states in which you conduct business and the type of business you have, you may be 
required to calculate sales tax on items sold and items purchased. The software allows you to calculate, 
track, and report sales tax information. To calculate sales tax, you must define information in Sales Tax 
Class Maintenance, Sales Tax Code Maintenance, and Sales Tax Schedule Maintenance. Sales tax 
information defined in these tasks is available to all companies.

The setup of sales tax information consists of the following four-part process:

 1. Defining Sales Tax Classes: The tax class is used to define tax classifications. These tax classes 
are then assigned to each sales code, inventory item and miscellaneous charge code.

 2. Defining Sales Tax Codes: The tax code is used to define whether a tax class is taxable. It is also 
used to define a tax rate, if applicable.

 3. Defining Sales Tax Schedules: A tax schedule groups individual tax codes.

 4. Assigning  Sales Tax Schedules: Tax schedules are assigned to each vendor and customer based 
on the vendor's location or purchase address and the customer's location or ship-to address.

Defining a Sales Tax Class

The first step in defining sales tax information is to define different types of tax classifications in Sales 
Tax Class Maintenance. The following three tax classes are defined automatically by the system and 
cannot be deleted: Nontaxable (NT), Taxable (TX), and Taxable Freight (TF). A tax class must be defined 
for each classification of goods and services that are taxed at different rates.

Note: The TF (Taxable Freight) tax class is used to calculate sales tax on freight amounts.
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To define a sales tax class

 1. Select Library Master > Setup > Sales Tax Class Maintenance.

 2. Enter a class in the Tax Class field.

 3. In the Description field, type a description for the tax class and click Accept. Repeat steps 2 and 3 
for each tax class you need to define.

After defining sales tax classes, assign the tax classes to sales codes, inventory items, and 
miscellaneous charges.

Defining a Sales Tax Code

After defining tax classes, you must define sales tax codes in Sales Tax Code Maintenance. You must 
set up a tax code for each tax jurisdiction (such as state, county, local or province) to which your business 
reports sales tax information. The defined sales tax codes determine the rate to calculate for each tax 
class defined in Sales Tax Class Maintenance and are used to determine if sales tax is calculated on 
both items sold and purchased.

To define a sales tax code

 1. Select Library Master > Setup > Sales Tax Code Maintenance.

 2. Enter a code in the Tax Code field and type a description in the Description and Short Description 
fields.

The short description will be used when printing tax detail on forms.
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 3. If the tax code you are defining has a limit, type it in the Taxable Limit field. For example, some tax 
jurisdictions have a limit for the amount of sales tax that can be defined on an invoice, sales order, 
or receipt.

 4. Complete one of the following options:

 l Select the Calculate Sales Tax on Retention check box to calculate sales tax on the invoice 
amount less retention. 

 l Clear the Calculate Sales Tax on Retention check box to calculate the sales tax on the full 
invoice amount, regardless of retention. For more information, see Sales Tax Code 
Maintenance - Fields in the help.

Note: The Calculate Sales Tax on Retention check box is available only if the Job Cost module 
is installed.

 5. Complete one of the following options:

 l Select the Expense to Vendor/Item check box to allocate the non-recoverable portion of 
purchase's sales tax to the vendor's expense account in Accounts Payable or to the inventory 
account in Purchase Order. 

 l Clear the Expense to Vendor/Item check box if the non-recoverable portion is not to be 
allocated. For more information, see Sales Tax Code Maintenance - Fields in the Help 
system.

 6. Complete one of the following options:

 l Select the Tax on Tax check box if this tax code is subject to taxation by other tax 
jurisdictions. Then enter a class to be used for tax-on-tax calculations in the Tax Class field 
(next to the Tax on Tax check box).

 l Clear the Tax on Tax check box if the tax code is not subject to tax on tax. For more 
information, see Sales Tax Code Maintenance - Fields in the help.

Note: The Tax Class field next to the Tax on Tax check box is the only place you can enter a tax-
on-tax tax class; you cannot enter this in Sales Tax Class Maintenance.

 7. For each tax class defined (except for tax class NT which cannot be maintained or deleted), 
complete the following:

 a. Select the Sales check box to calculate sales tax for this code, or clear the Sales check box if 
sales tax should not be calculated. 

 b. In the Tax Rate field, type the tax rate percentage to use for calculating taxes.
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 c. Select the Purchases check box if purchases are taxable for the tax class entered and 
proceed. Clear the Purchases check box if the purchases are not taxable and skip the next 
step.

 d. If the Purchases check box is selected, type the percentage of the purchase tax that cannot 
be recovered in the Non-Recoverable % field. 

 l Type 0 (zero) in this field if all purchases sales tax is to be posted to the Accounts 
Payable sales account. 

 l Type 100 in this field to post all of the purchases sales tax to the non-recoverable 
account.

Note: If your tax jurisdiction charges tax on freight, you must set up a tax rate for the TF tax class 
in each applicable tax code.

 8. Click Accept. The following example shows a rate of 7.25, which will be calculated for items 
assigned to the Taxable (TX) tax class for items sold.

Defining a Sales Tax Schedule

After defining sales tax codes, use Sales Tax Schedule Maintenance to group tax codes that make up a 
total sales tax rate for assignment to customers and vendors, and to establish whether tax detail will print 
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on sales orders and invoices. For example, if a specific county requires that you calculate both state and 
county tax, create a sales tax schedule that groups the state and county tax together.

To define a sales tax schedule

 1. Select Library Master > Setup > Sales Tax Schedule Maintenance.

 2. Enter a schedule in the Tax Schedule field and type a description in the Description field.

 3. In the Tax Code field, enter a tax code to add to this tax schedule and then click OK. 

Repeat this step for each tax code you want to add to the tax schedule. 

The sequence in which the tax codes are entered is very important because of tax-on-tax 
calculations and the establishment of the primary tax code. If a tax code is taxable by another tax 
code, it must be calculated first. 

For example, if tax code CA is taxable by tax code OR, CA would have to be calculated first to get 
an accurate calculation for the OR tax code. The first tax code entered will become the primary tax 
code. The primary tax code is used during the calculation of taxable and nontaxable amounts on 
each invoice and printing/updating of sales tax history.

 4. Click Accept.
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Assigning a Sales Tax Schedule

After sales tax schedules are defined, use Customer Ship-To Address Maintenance and Purchase 
Address Maintenance to assign each customer and vendor address to a default tax schedule. Default tax 
schedules can be changed when entering transactions.

To assign a sales tax schedule to a customer address

 1. Select Accounts Receivable > Main > Customer Maintenance.

 2. Enter the customer number. 

 3. Click the drop-down arrow in the top-right corner of the window, and then click Ship To Address.

 4. In the Customer Ship-To Address Maintenance window, enter a location code.

 5. In the Tax Schedule field, enter a sales tax schedule and then click Accept.
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To assign a sales tax schedule to a vendor address

 1. Select Accounts Payable > Main > Vendor Maintenance.

 2. Enter the vendor number.  Click the drop-down arrow in the top-right corner of the window, and then 
click Purchase Address.

 3. In the Purchase Address Maintenance window, enter the location code.

 4. In the Tax Schedule field, enter a sales tax schedule and click Accept.

Understanding How Sales Tax is Calculated
This lesson provides examples of how sales tax is calculated. These examples use the WI (Wisconsin) 
and WI MIL (Milwaukee) sales tax codes: 

 l The WI (Wisconsin state tax) sales tax code is set up to calculate sales tax at a rate of 5% on all 
sales and purchases for items assigned to the Taxable tax class. It will not calculate sales tax on 
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other tax classes.

 l The WI MIL (Milwaukee city tax) sales tax code is set up to calculate sales tax at a rate of 1% 
percent on all sales for items assigned to the Taxable tax class. It will not calculate sales tax on 
purchases or items assigned to other tax classes.

These examples also use the WI (Wisconsin) and WI MIL (Milwaukee) sales tax schedules:

 l The WI (Wisconsin) sales tax schedule has the WI sales tax code assigned to it.

 l The WI MIL (Milwaukee) sales tax schedule has both the WI sales tax code and the WI MIL sales 
tax code assigned to it because Milwaukee city requires that both state and city tax be calculated 
for taxable items.

57Sage 100 Getting Started Guide



Understanding How Sales Tax is Calculated

Example 1 - How Sales Tax is Calculated in Accounts Receivable

(This is the Drop-down text)

Example 2 - How Sales Tax is Calculated in Accounts Payable

This example shows how sales tax is calculated on Accounts Payable invoice 75-145. Invoice 75-145 
has the following settings:

 l On the Invoice Data Entry Header tab, the WI MIL tax schedule is selected.

 l On the Invoice Data Entry Lines tab, the total distribution amount for this invoice is $100.00. This is 
the total purchase amount that is taxable.
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Tax Calculated Using the WI MIL (Milwaukee) Sales Tax Schedule

To view how tax is calculated for invoice 75-145, on the Invoice Data Entry Header tab, click Tax Detail. 
In the Tax Detail window, you can see that $5.00 (100 x 5%) in sales tax has been calculated for the WI 
MIL (Wisconsin) sales tax schedule.

Remember that the WI MIL tax schedule calculates tax for both WI (Wisconsin state) and WI MIL 
(Milwaukee city) sales tax codes. Also, keep in mind that the WI sales tax code is set up to calculate 
sales tax on items which are purchased (the Purchases check box is selected in Sales Tax Code 
Maintenance), but the WI MIL tax code is not set up to calculate sales tax on items which are purchased 
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(the Purchases check box is cleared in Sales Tax Code Maintenance). Therefore, sales tax on 
purchased items is calculated only for the WI (Wisconsin) state tax code even though both tax codes (WI 
and WI MIL) are included in the WI MIL tax schedule.

Changing Sales Tax Information
After setting up sales tax information, you may need to modify the sales tax information defined in Sales 
Tax Class Maintenance, Sales Tax Code Maintenance, or Sales Tax Schedule Maintenance. For 
example, the sales tax rate for a tax jurisdiction changed.

Note: This lesson assumes that sales tax information has been set up and sales tax has already 
been calculated on transactions.

To change sales tax information

 1. On the Library Master  Setup menu, select one of the following:

 l Sales Tax Class Maintenance

Sales Tax Code Maintenance

Sales Tax Schedule Maintenance
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 2. A warning message appears informing you that changes you make may impact sales tax 
calculations and reporting. Click OK.

 3. Make the necessary changes and then click Accept.

 4. You must recalculate the sales tax previously calculated on unposted invoices, sales orders, 
purchase orders, manual checks, returns, and so on. 

Warning! Before recalculating sales tax, back up all data files.

To recalculate sales tax, select one of the folloing:

 l Accounts Payable >Utilities > Sales Tax Calculation

 l Accounts Receivable > Utilities > Sales Tax Calculation.

 5. In the Sales Tax Calculation Utility window, select one of the following options:

 l Select the Recalculate Sales Tax for all Records option to recalculate taxes for all records.

 l Select the Recalculate Sales Tax for Flagged Records Only option to recalculate taxes for 
only those records that are flagged as invalid tax calculation.

 6. Click Proceed to recalculate the sales tax.

When sales tax is recalculated, the following occurs:

 l Only unposted transactions are affected. This includes sales orders, purchase orders, and 
unposted invoices.
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 l Posted transactions are not modified. If the amount of sales tax calculated was incorrect, you must 
manually adjust the invoice through a credit memo or debit memo.

 l Recurring invoices are updated if they contain sales tax information.
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Troubleshooting

What are System Messages?
When the computer system encounters a condition requiring your attention, a System Message dialog 
box appears.

System Message Dialog Box Example

 

Some messages reflect a normal operational situation, such as the printer being off-line. Usually, the 
resolution is simple, and you can proceed without difficulty. 

Other messages can indicate a problem with the hardware or with the data files. A problem of this nature 
may require help from your Sage business partner. 

Obtaining Additional Information

If a message dialog box appears, click Info in the Error window to obtain additional information about the 
message.
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Before contacting a Customer Support or your Sage business partner, write down any system messages 
appearing on your monitor. Copy the message and indicate the program and function being performed 
when the message occurred. Click the Print button to print the error information. 
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Overview of Module Startup

This article explains how to successfully upgrade from another business management system to 
Sage 100.

Accounts Payable 
The Accounts Payable module includes an Accounts Payable Setup Wizard that you must perform to 
convert your existing companies and account structure.

Note: Set up your sales tax codes, sales tax classes, and sales tax schedules in Library Master 
before using the Accounts Payable Setup Wizard.

The Accounts Payable Setup Wizard provides several pages of questions and options that aid you in 
quickly setting up the Accounts Payable module for new companies; you must complete this wizard and 
the "Conversion Process" (page 65) before using the Accounts Payable module.

Data You Need

Before using the Accounts Payable Setup Wizard, have the following information assembled and 
available for use: 

 l Your General Ledger Chart of Accounts

 l Your bank account number(s) for the checking accounts used by Accounts Payable

 l A list of standard payment terms offered by your vendors

 l A list of your vendors, including address and phone numbers

 l A list of all unpaid invoices to be processed

To obtain correct information from your Accounts Payable module, you must first bring it up to date with 
your existing accounts payable system.

Conversion Process

Complete the following process to ensure that your system is current. These steps should be performed 
after completing the setup wizard and after adding all of your information to the Accounts Payable 
module.
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To convert your existing accounts payable system

 1. Identify all unpaid invoices as of your last closed accounting period. 

 2. Prepare an adding machine tape totaling the invoices. This amount should equal the account 
balance for Accounts Payable in your general ledger. 

 3. Set the posting date to the last day of the last closed accounting period. 

 4. Using Invoice Data Entry, enter these invoices into the system. Enter the outstanding balance 
amount for each invoice as of the end of the last closed accounting period. During the distribution 
process, post the entire distribution balance to your Accounts Payable general ledger account. 
This is done because you have already expensed these invoices in a previous accounting period, 
and to do so again would duplicate those expenses. 

By posting to the Accounts Payable account, both a debit and an automatic credit are generated in 
the same amount to the Accounts Payable general ledger account; therefore, the two amounts 
offset each other and there is no effect on the general ledger. After the conversion process, you 
would not normally post to the Accounts Payable general ledger account, but would post to 
individual general ledger accounts, as appropriate. 

As an alternative to this procedure, clear the General Ledger check box in Accounts Payable 
Options. You can then distribute invoices to their respective accounts and no general ledger 
postings are made. If you use this alternate procedure, be sure to select the General Ledger check 
box again in Accounts Payable Options after the conversion process has completed and you have 
updated the Daily Transaction Register.

 5. Print the Invoice Register. The total shown on the Invoice Register should equal the total on the 
adding machine tape prepared in step 2. If it does not, an error has been made. Check your adding 
machine tape and Invoice Register, return to Invoice Data Entry and make any necessary 
corrections, and then reprint the Invoice Register.

 6. Update the invoices.

 7. Print the Aged Invoice Report available on the Accounts Payable Reports menu, and retain a copy 
of this report for your accounting files. Again, the total on this report should equal the adding 
machine tape total.

 8. Run Period End Processing by selecting Period End Processing from the Period End menu, and 
then clicking Proceed. 

 9. Reset the posting date to the first day of the current accounting period. 

 10. Using Invoice Data Entry, enter any invoices you have received since the last closed accounting 
period. (These invoices should not include any invoices entered in step 4.) Post the distribution 
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balance of each invoice to its appropriate general ledger account (not to the Accounts Payable 
general ledger account). Print the Invoice Register and update the invoices. 

Important! If the General Ledger check box is cleared in Accounts Payable Options, select the 
General Ledger check box before proceeding with the update.

 11. Prepare an adding machine tape totaling any checks you have written since your last closed 
accounting period. 

 12. Using Manual Check and Payment Entry, enter these checks (step 11) into the system. If the check 
paid an invoice previously entered (step 4 or 10), no general ledger distribution is required. Type 
the invoice number exactly as you did when you entered it in step 10. If the check paid an invoice 
that you did not previously enter, you must distribute it to the appropriate general ledger account
(s).

 13. Print the Manual Check and Payment Register. The total should equal the total of the adding 
machine tape prepared in step 11. If it does not, return to Manual Check and Payment Entry, 
correct the necessary entries, and reprint the Manual Check and Payment Register. When the 
register total and the adding machine tape agree, update the manual checks.

 14. Print the Aged Invoice Report and verify that all invoices paid by the manual checks recorded in 
step 12 are listed as paid.

You are ready to begin using your Accounts Payable module.

Accounts Receivable
The Accounts Receivable module includes an Accounts Receivable Setup Wizard that you must perform 
to convert your existing companies and account structure.

The  Setup Wizard provides several pages of questions and options that aid you in quickly setting up the 
Accounts Receivable module for new companies; you must complete this wizard and the "Conversion 
Process" (page 68) before using the Accounts Receivable module.

Note: Set up your sales tax codes, sales tax classes, and sales tax schedules in Library Master 
before using the Accounts Receivable Setup Wizard.

Data You Need

Before using the Accounts Receivable Setup Wizard, have the following information assembled and 
available for use:
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 l Your General Ledger Chart of Accounts

 l A list of jurisdictions in which you sell and collect sales tax and their tax rates

 l A list of standard payment terms offered to your customers

 l A list of your customers, including addresses and phone numbers

 l A list of all invoices to process

 l A list of all payments to process

To obtain correct information from your Accounts Receivable module, you must first bring it up to date 
with your existing accounts receivable system.

Conversion Process

Complete the following process to ensure that your current accounting system is in balance. These steps 
should be performed after completing the setup wizard and after adding all your customers to the 
Customer file. If you maintain Accounts Receivable customers using a balance forward method, it is not 
necessary to enter each invoice. For balance forward customers, total all unpaid invoices for each aging 
category, and enter an invoice for each aging category for each customer. 

To convert your existing accounts receivable system 

 1. Identify all unpaid invoices as of your last closed accounting period.

 2. Prepare an adding machine tape totaling the invoices. This amount should equal the account 
balance for Accounts Receivable in your general ledger. 

 3. Set the posting date to the last closed accounting period. 

 4. Using Invoice Data Entry, enter the invoices using the original invoice dates. During the distribution 
process, post the entire distribution balance to your Accounts Receivable general ledger account 
number. These invoices are already posted in an accounting period, and to post them again would 
duplicate the postings. 

By posting to the Accounts Receivable general ledger account, both a credit and an automatic 
debit are generated in the same amount to the Accounts Receivable general ledger account. The 
two amounts offset each other and there is no effect on the general ledger. 

After the conversion process, you will not normally post to the Accounts Receivable general ledger 
account, but will post to individual general ledger accounts, as appropriate. 

As an alternative to this procedure, in Accounts Receivable Options, clear the General Ledger 
check box. You can then distribute invoices to their respective accounts and no general ledger 
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postings will occur. If you use this alternate procedure, be sure to select the General Ledger check 
box again in Accounts Receivable Options after the conversion process has completed and you 
have updated the Daily Transaction Register.

 5. Print the Sales Journal. The invoice total shown on the Sales Journal should equal the total on the 
adding machine tape prepared in step 2. If it does not, an error has been made. Check the adding 
machine tape and the Sales Journal, return to Invoice Data Entry and make any necessary 
corrections, and then reprint the Sales Journal.

 6. Update the invoices.

 7. Print the Aged Invoice Report and retain a copy of this report for your accounting files. The total on 
this report should equal the adding machine tape total.

 8. Run Period End Processing by selecting Period End Processing from the Period End menu, and 
then clicking Proceed.

 9. Reset the posting date to the first day of the current accounting period.

 10. Using Invoice Data Entry, enter any invoices billed since the last closed accounting period. (These 
invoices should not include any invoices entered in step 4.) Post the distribution balance of each 
invoice to its appropriate general ledger account (not to the Accounts Receivable general ledger 
account). Print the Sales Journal and update the invoices.

Important! If the General Ledger check box is cleared in Accounts Receivable Options, select 
the General Ledger check box before proceeding with the update.

 11. Prepare an adding machine tape totaling any cash receipts you received since your last closed 
accounting period.

 12. Using Cash Receipts Entry, enter these cash amounts. For the deposit amount, enter the adding 
machine tape total prepared in step 11. If the checks entered represent payment for a previously 
issued invoice (step 4 or 10), no general ledger distribution is required. If any checks represent 
payment for an invoice not previously issued, you must distribute the amounts to the appropriate 
general ledger accounts.

 13. Print the Cash Receipts Journal. The total should equal the adding machine tape total in step 11. If 
it does not, return to Cash Receipts Entry, correct the necessary entries, and reprint the Cash 
Receipts Journal. When the journal total and the adding machine tape agree, update the cash 
receipts.

 14. Print the Aged Invoice Report and verify that all invoices that are paid by the cash receipts 
recorded in step 12 are listed as paid. 

You are ready to begin using your Accounts Receivable module.
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Bank Reconciliation
To obtain correct information from your Bank Reconciliation module, you must first bring it up to date with 
your existing bank reconciliation system. 

To convert your existing bank reconciliation system 

 1. Verify that all modules being integrated with Bank Reconciliation are fully installed and operational. 

 2. Select the Bank Reconciliation check box in General Ledger Options, Accounts Payable Options, 
Accounts Receivable Options, Payroll Options, and Purchase Order Options, as appropriate. 

 3. Manually reconcile the last bank statement for each account that you want to use in your bank 
reconciliation system. 

 4. Perform all preliminary startup activities (define the files and set the accounting date using the 
ending date shown on your last reconciled bank statement). 

 5. Using Bank Code Maintenance, set up the bank code using the ending bank balance from your last 
reconciled bank statement as a source for the bank account number and ending bank balance. 

 6. Enter all outstanding checks from your last reconciled bank statement, using Check, Deposit and 
Adjustment Entry. If checks are already being processed through the Accounts Payable or Payroll 
module, these outstanding checks should be checks that were updated in the check update 
process, but are not shown on the last bank statement. On the Check tab, clear the Cleared check 
box when these checks are recorded. 

 7. Enter all outstanding deposits or adjustments (those not shown on the bank statement) in Check, 
Deposit and Adjustment Entry. If deposits are being processed through the Accounts Receivable 
module, these outstanding deposits should have been updated, but not shown, on the last bank 
statement. On the Check tab, clear the Cleared check box when these deposits and adjustments 
are recorded. 

Print the Bank Reconciliation Register to verify the accuracy of the information entered. If the information 
on the register is correct, your Bank Reconciliation module is now ready to use. 

Mobility for Bar Code
Before using the Mobility for Bar Code module, create and have available the folder names that will be 
used for importing files from the hand-held computer. Enter this information in  Mobility for Bar Code Bar 
Code Options, which is located on the Setup menu.
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Bill of Materials
The Bill of Materials module includes a Bill of Materials Setup Wizard that you must perform to convert 
your existing companies and account structure.

The Bill of Materials Setup Wizard provides several pages of questions and options that aid you in quickly 
setting up the Bill of Materials module for new companies; you must complete this wizard and the 
"Conversion Process" (page 71) before using the Bill of Materials module.

Data You Need

Before using the Bill of Materials Setup Wizard, have the following information assembled and available 
for use:

 l Your General Ledger Chart of Accounts 

 l A single-level bill of materials listing for all bills you want to maintain 

 l Any miscellaneous codes that you want to set up, such as for overhead, labor, and outside 
processing

To obtain correct information from your Bill of Materials module, you must first bring it up to date with your 
existing bill-processing system. 

Conversion Process

Complete the following process to ensure that your system is current. These steps should be performed 
after completing the setup wizard. 

To convert your existing bill of materials system 

 1. Prepare a list of existing bills from your system. Verify that the information is current. 

 2. Review the structure of the existing bills. When possible, employ the modular bill structure to save 
work and provide increased flexibility. 

 3. Enter the bills in Bill of Materials Maintenance. 

 4. Enter the component items, miscellaneous codes, and comments for each bill. If your bills use bill 
options, examine the bills to verify that all options and any option interactions are taken into 
account. 

 5. Print a Single-Level Bill of Materials Report for all bills and verify the information against the listings 
provided in your old system. Print an Indented Bill of Materials Report and verify that the bill 
structure is correct and complete.
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 6. Print a Bill Validation Report. This report examines the entire Bill of Materials file. Correct any 
inaccuracies and print this report again, if applicable.

You are ready to begin using your Bill of Materials module.

Common Information
The Common Information module includes a Common Information Setup Wizard that you must perform 
to convert your existing companies and account structure.

The Setup Wizard provides several pages of questions and options that aid you in quickly setting up the 
Common Information module for new companies; you must complete this wizard before using the 
Common Information module.

Data You Need

Before using the Common Information Setup Wizard, have the following information assembled and 
available for use:

 l A list of miscellaneous items and charges 

 l A list of sales tax jurisdictions

 l Your bank account number(s) 

eBusiness Manager
The eBusiness Manager module includes an eBusiness Manager Setup Wizard that you must perform to 
convert your existing companies and account structure.

The eBusiness Manager Setup Wizard provides several pages of questions and options that aid you in 
quickly setting up the eBusiness Manager module for new companies; you must complete this wizard 
before using the eBusiness Manager module.

Data You Need

Before using the eBusiness Manager Setup Wizard, have the following information assembled and 
available for use: 

 l The IP address and port number for each of the three servers (IIS, SMTP, and Web Engine)

 l A list of your item categories
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 l A list of user IDs and passwords to assign to Internet-enabled customers (for the .order applet 
only)

 l A list of user ID e-mail addresses and the company to which each user is assigned

For more information regarding setup procedures, refer to the eBusiness Manager Installation Guide, 
which is available on the Sage 100 documents page.

General Ledger
The General Ledger module includes a General Ledger Setup Wizard that you must perform to convert 
your existing companies and account structure.

The Setup Wizard provides several pages of questions and options that aid you in quickly setting up the 
General Ledger module for new companies; you must complete this wizard and the "Conversion 
Process" (page 73) before using the General Ledger module to process your daily transactions.

Data You Need 

Before using the General Ledger Setup Wizard, you should have the following information assembled 
and available for use:

 l Your General Ledger Chart of Accounts

 l A Trial Balance from the last completed accounting period 

 l Copies of your company's latest financial statements, including the Income Statement and 
Balance Sheet

Conversion Process

To obtain correct information from your General Ledger module, you must first bring it up to date with 
your existing general ledger system. 

 l If you are converting at the beginning of a fiscal year, or require only the beginning balances for 
each account, see Enter Beginning Balances in the Help system. 

 l If you are converting in the middle of a fiscal year and want to record activity for each accounting 
period of the current year, as well as beginning balances, see Enter Data for Each Period in the 
Help system. 

Use these procedures as a checklist to ensure that your current accounting system is in balance. These 
procedures should be performed after completing the General Ledger Setup Wizard.
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Inventory Management
The Inventory Management module includes an Inventory Management Setup Wizard that you must 
perform to convert your existing companies and account structure.

The Setup Wizard provides several pages of questions and options that aid you in quickly setting up the 
Inventory Management module for new companies; you must complete this wizard and the "Conversion 
Process" (page 74) before using the Inventory Management module.

Data You Need

Before using the Inventory Management Setup Wizard, have the following information assembled and 
available for use: 

 l Your General Ledger Chart of Accounts 

 l A list of all inventory items containing costs, prices, on-hand quantities, warehouse locations, and 
reorder requirements

 l Any shipping documents, receiving reports, open purchase orders, or adjustment vouchers that 
must still be processed

To obtain correct information from your Inventory Management module, you must first bring it up to date 
with your existing inventory system. 

Conversion Process

Complete the following process to ensure that your current accounting system is in balance. These steps 
should be performed after completing the setup wizard and after adding all your inventory items to the 
Inventory file. 

To convert your existing inventory system 

 1. Prepare a list of current on-hand quantities for all inventory items. You can use the balances as of 
your last closed inventory accounting period end, or you can perform a physical count.

 2. In Inventory Management Options, in the Current Inventory Period field, select the previous period 
(the last closed period).

 3. In Inventory Management Options, clear the General Ledger check box. 

 4. Set the posting date to the last day of the last closed accounting period. 

 5. In Transaction Entry, enter each item's current on-hand quantity as a receipt by selecting Receipts 
in the Transaction Type field. You must enter the quantity on hand and the unit cost for each item. 
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 6. You can use a single receipt reference for entering the on-hand quantities for all items, or items 
can be separated into any logical grouping and entered under different references. 

 7. Print the Transaction Journal and verify all information. If necessary, use Transaction Entry to 
make corrections. 

 8. When the register is correct, perform the Transaction Journal update.

 9. In Period End Processing, select Full Period End Processing. The current period is set to the 
period in which you begin processing.

 10. In Inventory Management Options, select the General Ledger check box. 

 11. Reset the posting date to the first day of the current accounting period. 

 12. Enter any transactions, such as sales, issues, and receipts for the current accounting period to 
bring the inventory management system up to date. Use Transaction Entry to record the 
transactions. 

You are ready to begin using your Inventory Management module.

Job Cost
The Job Cost module includes a Job Cost Setup Wizard that provides several pages of questions and 
options that aid you in quickly setting up the Job Cost module for new companies. You must run this 
wizard and complete the "Conversion Process" (page 76) before using the Job Cost module.

Data You Need

Before using the Job Cost module, have the following information assembled and available for use:

 l Your General Ledger Chart of Accounts

 l Determine your accounting and billing methods

 l Estimates or estimate worksheets

 l Job contracts with all pertinent information

 l Estimated price lists

 l Standard cost code list

 l Job types list 

 l Burden rate information 
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 l Overhead rate information 

 l Invoices or billing documents that need to be processed

To obtain correct information from your Job Cost module, you must first bring it up to date with your 
existing job costing system. 

Conversion Process

Complete the following process to ensure your system is current. These steps should be performed after 
completing System Startup and adding all jobs, cost codes, and cost types to the Job Cost master file.

To ensure that all accounting modules integrated with Job Cost, including the Accounts Payable, 
Accounts Receivable, Payroll, Purchase Order, and Sales Order modules, do not double post 
transactions that have been entered as part of the conversion process, it is recommended that the 
conversion process be performed immediately after the completion of period-end processing for all 
integrated modules.

To convert from your existing job cost system

 1. Prepare a list of job-to-date cost information, detailed by cost code and cost type, for each open 
job. You should use the information from your last closed accounting period. If you are changing 
the coding format of your cost codes from your previous system, indicate the new cost codes to 
use for each entry. 

 2. In Job Cost Options, clear the Post to G/L for Direct Cost Transactions and Post to G/L for Billing & 
Cash Receipt Transactions check boxes. The job-to-date conversion information to be entered 
should not be posted to the general ledger. 

 3. Set the Job Cost accounting date to the last day of the last closed accounting period. 

 4. In Job Posting Entry, enter a separate batch of direct cost entries for each job. Enter a separate 
entry with the job-to-date units (quantity) and job-to-date cost for each cost code and/or cost type 
detail. If each job contains a large number of cost code and/or cost type detail, update each batch 
separately. 

 5. If the Accounts Receivable module is not integrated with Job Cost, use Job Posting Entry to enter 
billing and cash receipt transactions for each job up to the last closed accounting period. Do not 
enter any billing or cash receipts that should be recorded in the current accounting period. 

 6. If the Accounts Receivable module is integrated with Job Cost, use Job Billing Entry to enter all 
invoices that have been billed to outstanding jobs. Use Accounts Receivable Cash Receipts Entry 
to enter cash receipts for job invoices. If Job Cost is integrated with the General Ledger module, 
you must use General Journal Entry to back out these general ledger postings generated for these 
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transactions to prevent double posting of information previously recorded. 

Additionally, if invoices relating to job billing are entered in the Accounts Receivable module before 
the installation of Job Cost, reverse these invoices using the Adjustment feature in Accounts 
Receivable Invoice Data Entry before recording the job invoices. This prevents doubling the 
invoice information in the Accounts Receivable module. 

 7. If work-in-process accounting is being used, the initial job billing entries generate postings to the 
General Ledger module that adjust the appropriate work-in-process accounts with the total 
accumulated costs for each job. You must use General Journal Entry to back out these general 
ledger postings to prevent double posting of information previously recorded. 

 8. Print the Work in Process Report for all jobs, and check the cost code, cost type, and job-to-date 
information printed. Print the Job Billing History Report to check the billing and cash receipt 
transactions. If any errors are found, use Job Posting Entry or Job Billing Data Entry to make 
corrections. 

 9. Perform full period-end processing to clear the period-to-date information affected by the 
conversion data. 

 10. Reset the accounting date to the first day of the current accounting period. 

 11. Enter cost and billing transactions for the current accounting period. Transactions can be entered 
directly in the Job Cost module by integration with other modules.

 12. In Job Cost Options, select the Post to G/L for Direct Cost Transactions and Post to G/L for Billing 
& Cash Receipt Transactions check boxes. This allows all future transactions to post to the general 
ledger.

You are ready to begin using your Job Cost module.

Material Requirements Planning
Before using the Material Requirements Planning module, have a list of available warehouses ready for 
use, and know whether each warehouse is a standard distribution/manufacturing warehouse or a 
distribution warehouse that will receive only transferred goods. This information will be used to define 
warehouse groups in Warehouse Group Maintenance.

Payroll
The Payroll module includes a Payroll Setup Wizard that provides several pages of questions and 
options that aid you in quickly setting up the  module for new companies. You must run this wizard and 
complete the conversion process before using the Payroll module.
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Data You Need

Before using the Payroll module, have the following information assembled and available for use: 

 l Your General Ledger Chart of Accounts 

 l A list of the earnings and deductions used for payroll processing 

 l Employer federal, state, and local tax ID numbers for each tax jurisdiction in which your employees 
are paid 

 l Any company-specific tax rates, such as federal and state unemployment insurance tax rates. 

 l A list of employees, complete with personal information and quarter-to-date and year-to-date 
earnings and deduction history

To obtain correct information from your Payroll module, you must first bring it up to date with your existing 
payroll system. 

In compliance with federal and state tax reporting requirements, payroll systems operate on a calendar-
year basis. As the year progresses, large quantities of quarter-to-date and year-to-date data are 
accumulated; therefore, the ideal time to convert from your existing payroll system to the Payroll module 
is on January 1. If this is not possible for your company, guidelines for installing the Payroll module at 
different times during the year follow. 

Converting at the Beginning of the Calendar Year

If you are installing the Payroll module at the beginning of the calendar year, enter your information into 
the module; however, make no entries at any quarter-to-date or year-to-date fields. These fields are 
maintained automatically as payroll is processed throughout the year. With these tasks completed, you 
can proceed directly to the year's first payroll cycle. 

Converting in the Middle of the Calendar Year

To obtain correct year-end totals and proper tax calculations from your Payroll module, you must first 
bring it up to date with your current payroll totals, including quarter-to-date and year-to-date earnings and 
a record of accrued time-off hours.

Payroll Setup Wizard

You must run the Payroll Setup Wizard before completing any other tasks in the module. 

To run the wizard, select Payroll > Setup > Payroll Options. If the company has not been set up, a 
message asks if you want to set up the module. Click Yes to start the wizard. 
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To record year-to-date information

 1. Enter all employee information into the system.

 2. In Company Tax Group Setup, select the Federal tax group. On the Tax Rates tab, in the Tax field, 
select Federal Unemployment Tax Employer Liability. Enter the effective date and your company's 
tax rate (if applicable). 

 3. In Company Tax Group Setup, select each applicable state and local tax group. On the Tax Rates 
tab, in the Tax field, select the applicable tax, and then enter the effective date and your company's 
tax rate (if applicable).

 4. In Payroll Options, in the Current Quarter field, select the previous quarter. 

 5. In Payroll Options, in the Integrate With section, clear the General Ledger check box. This ensures 
that no general ledger postings are made from the Payroll module. Because the prior quarter 
information should already be reflected in your general ledger balances, allowing the postings to 
update would result in duplicate postings. 

If you are using the Bank Reconciliation module, clear the Bank Reconciliation check box also. 

 6. Enter manual checks using Payroll Data Entry for each employee to record the year-to-date 
earnings and tax information. In the Pay Cycle window, verify the Manual Taxes check box is 
selected and the Print Checks check box is cleared. You can use the previous quarter number as 
the check number. Enter all earnings, deductions, and tax information using the year-to-date 
information from the end of the previous quarter. 

If an employee has worked in more than one state, make sure the earnings information is entered 
separately for each state. 

 7. Print the Payroll Data Entry Audit Report and verify all information. If necessary, make any 
corrections using Payroll Data Entry. 

 8. Print the Employer's Expense Summary to ensure that employer taxes and Workers’ 
Compensation are calculated as expected. Verify that deposit liability amounts match to what you 
have paid year-to-date as of the end of the previous quarter.

 9. Print the Check Register and perform the Check Register update. 

 10. In Period End Processing, select Quarter End Processing and print the period-end reports. Verify 
that the information is correct and make corrections if needed. 

The Current Quarter field in Payroll Options increments to the current quarter. 

If you are converting your payroll at the beginning of the current quarter, proceed to step 5 in the 
procedure below. 
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If you are converting in the middle of the quarter, you must record each check issued during the 
current quarter using the following procedure.

To record current quarter checks

 1. Enter each check issued during the current quarter as a manual check in Payroll Data Entry (that 
is, in the Pay Cycle window, clear the Print Checks check box and select the Manual Taxes check 
box). Enter the earnings, deductions, and tax information exactly as written on the original checks. 

You can enter a combined total of the checks issued for each employee. This method, however, 
does not provide the full detail and complete audit trail facilitated by a detailed entry of each check. 

 2. Print the Payroll Data Entry Audit Report and verify the accuracy of all entries. If necessary, make 
any corrections using Payroll Data Entry and reprint the Payroll Data Entry Audit Report. 

 3. Print the Employer's Expense Summary report to ensure that employer taxes and Workers’ 
Compensation are calculated as expected and that deposit liability amounts match what you have 
paid.

 4. Print the Check Register and perform the Check Register update. 

 5. Print the Quarterly Tax Report and the Payroll Check History Report, and verify that all employee 
information and tax rates are correct. 

 6. Print and verify the Time Off Register. If adjustments are necessary, access individual employee 
records in Employee Maintenance. 

 7. In Payroll Options, select the General Ledger check box. This allows all future payroll processing 
to post to the general ledger. 

If you are using the Bank Reconciliation module, select the Bank Reconciliation check box. 

You are ready to begin using the Payroll module.

Purchase Order
The Purchase Order module includes a Purchase Order Setup Wizard that you must perform to convert 
your existing companies and account structure.

The Purchase Order Setup Wizard provides several pages of questions and options that aid you in 
quickly setting up the Purchase Order module for new companies; you must complete this wizard and the 
"Conversion Process" (page 81) before using the Purchase Order module.

Data You Need

Before using the Purchase Order Setup Wizard, have the following information available for use:
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 l Your General Ledger Chart of Accounts 

 l A list of vendor quantity discount rates you use for inventory items

 l A list of all addresses to which you have orders shipped

 l All open purchase orders and back orders

 l All receipts, invoices, returns, and material requisitions as of your last closed accounting period

To obtain correct information from your Purchase Order module, you must first bring it up to date with 
your existing purchase order system. 

Conversion Process

Complete the following process to ensure that your current accounting system is in balance. These steps 
should be performed after completing the setup wizard. 

To convert your existing purchase order system 

 1. Gather all open purchase orders as of your last closed accounting period. 

 2. Prepare an adding machine tape totaling the orders. 

 3. Use Purchase Order Entry to enter the orders into the system. In Default Values for Purchase 
Order Entry, clear the Print Purchase Orders check box to prevent the conversion orders from 
being reprinted. Next, on the Purchase Order Entry Header tab, select Standard Order in the Order 
Type field and Open in the Order Status field for each order. 

Partially received or invoiced purchase orders cannot be processed using the system without 
double posting to the General Ledger and Inventory Management modules. These orders should 
be processed manually until they are completed. To enter these orders, you must enter only the 
unreceived balance on each order as the original order quantity. There are no such restrictions for 
outstanding orders that have not received any partial receipts or invoices against them. 

 4. Print the detail version of the Open Purchase Order Report for all order types and orders with an 
open status. The total on this report should equal the total on the adding machine tape you 
prepared in step 2. If the totals do not agree, return to Purchase Order Entry and make any 
necessary corrections and reprint the report as an audit record of your outstanding orders. 

 5. Record all receipts, invoices, returns, and material requisitions that you have received since the 
last closed accounting period to bring the system completely up to date. 

You are ready to begin using your Purchase Order module.
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Sales Order
The Sales Order module includes a Sales Order Setup Wizard that you must perform to convert your 
existing companies and account structure.

The Setup Wizard provides several pages of questions and options that aid you in quickly setting up the 
Sales Order module for new companies. You must complete this wizard and the "Conversion Process " 
(page 82) before using the Sales Order module to process your daily transactions.

Data You Need

Before using the Sales Order Setup Wizard, have the following information assembled and available for 
use: 

 l Your General Ledger Chart of Accounts

 l A list of standard miscellaneous charges and items used in your business

 l A list of item part numbers sold by your business (if the Inventory Management module is not 
integrated with Sales Order)

 l A list of your shipping rates

 l All open orders and back orders

 l A Customer Listing from your Accounts Receivable module

 l An Inventory Item Listing from your Inventory Management module

To obtain correct information from your Sales Order module, you must first bring it up to date with your 
existing order processing system. 

Conversion Process 

Complete the following process to ensure that your current accounting system is in balance. These steps 
should be performed after completing the setup wizard. First, enter any unpaid invoices, as of your last 
closed accounting period, into the Open Invoice file. This process is performed using the Accounts 
Receivable module. Second, use the Sales Order module to enter any open orders or back orders into 
the system. 

To convert your existing sales order system 

 1. Identify all open orders as of your last closed accounting period. 

 2. Prepare an adding machine tape totaling the orders. 
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 3. Using Sales Order Entry, enter these orders into the system. Use the standard order type for 
standard sales orders, and the open order status for open orders. When entering the Sales Order 
Entry default values, clear the Print Sales Orders and Print Pick Sheets check boxes, and enter 00 
in the No. of Ship Labels field in the Default Values for Sales Order Entry dialog box to prevent 
these documents from being printed. 

 4. Identify all open back orders as of your last closed accounting period. 

 5. Prepare an adding machine tape totaling the back orders. 

 6. Using Sales Order Entry, enter these back orders into the system. Use the back-order order type 
for back orders, and the open order status for open orders. 

 7. Print the detail version of the Open Sales Order Report for all order types and the open order 
status. The Open Order and Open Back Order totals shown on this report should equal the totals 
on the adding machine tapes prepared in steps 2 and 5. If the totals do not agree, check your 
adding machine tapes and the Open Sales Order Report. Return to Sales Order Entry and make 
any necessary corrections, and then reprint the report as an audit record of your outstanding 
orders. 

You are ready to begin using the Sales Order module.

Work Order
Before using the Work Order module, have the following information assembled and available for use:

 l Your General Ledger Chart of Accounts

 l A list of work center locations, including the number of employees and number of standard hours 
available per week at each location

 l A list of operations to be performed, including cost and overhead calculations and general ledger 
production cost accounts

 l A list of employees (optional), including labor rates and social security numbers

 l A list of labor crews (optional), including the employees in each crew

 l A calendar of days when the entire shop is closed

 l A calendar for each work center with exceptions to the shop calendar

 l A list of tools to be used during operations (optional)

To obtain correct information from your Work Order module, you must first bring it up to date with your 
existing work order system. 

83Sage 100 Getting Started Guide



Work Order

Because the Inventory Management module is integrated with Work Order, it may be impractical to bring 
the system up to date and reconstruct the original material cost information that should have been 
recorded. If you have installed the Inventory Management module, it is difficult to record past material 
issue transactions for work orders without affecting the current inventory balances. 

The easiest and most effective way to convert the Work Order module is to enter only new work orders 
into the system. Do not record any transactions related to preexisting work orders using the Work Order 
module. You can use the Inventory Management module or the Bill of Materials module to record issues 
and receipts related to these work orders. For labor and miscellaneous expenses, the general ledger can 
be adjusted directly using General Ledger General Journal Entry. If the duration of your work orders is 
short, you can quickly complete the conversion process after all of the preexisting work orders are 
completed. 

Conversion Process

Complete the following process to ensure that your current accounting system is in balance. 

To convert your existing work order system

 1. In Work Order Options, clear the General Ledger check box to prevent any postings being made to 
the general ledger while entering conversion information.

 2. Enter all open work orders using Work Order Entry. 

 3. Enter all transactions recorded for open work orders using Work Order Transaction Entry. Material 
costs may not be the same as the original costs. 

 4. Print the Work Order Transaction Journal, and perform the update. 

 5. Print the Open Work Order Report to verify the information recorded. If adjustments are necessary, 
repeat steps 3 and 4. 

 6. Print the Work in Process Recap report to verify the information recorded and to reconcile to the 
general ledger.

 7. If you are entering material transactions for existing work orders, you can freeze inventory and 
perform a physical count and physical count entry without updating. Updating the Physical Count 
Variance Register should be performed only after all material issue transactions are recorded for 
existing work orders. 

Adjustments made during the Physical Count Variance Register update are recorded as physical 
adjustments in the Inventory Management Detail Transaction file. The Inventory Adjustment 
account in each item's product line is used to offset the Inventory account posting, unless the 
General Ledger check box is cleared in Inventory Management Options during the update process.
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 8. Perform the physical inventory process to update the quantity-on-hand information in inventory. 
This step should be performed after all material issue transactions have been recorded for open 
work orders. 

You are ready to begin using your Work Order module. 
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